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Resell Rights Licensing
Congratulations! You Now Have Full Master Resale Rights To This 

Instructional PDF Guide Ebook

You now officially have a Full Master Resale Rights License to this product. It 
can be sold for any dollar amount you decide it is worth. However, you are 
encouraged NOT to resell it for $1.00 or something similarly low as it would 
devalue the product entirely. A good base price to start reselling at would be 
between $15 to $30 respectively.

There are no pricing restrictions placed herein. The above are simply 
guidelines for pricing. The only restriction is that you must charge some 
dollar amount for the guide. This license will pass on to your customers 
also exactly as you have received it here when purchasing this product.

Here is a more detailed breakdown of what can and cannot be done with the 
ebook guide:

[YES] Edit/Alter the Sales Materials - Text/Graphics
[YES] Add to Paid Membership Sites
[YES] Can be Packaged with Other Products
[YES] Can Be Added As Bonus to Paid Product
[YES] Can Sell Standard/Basic Resale Rights
[YES] Can Sell Master Resale Rights
[NO] Can Sell Private Label Rights
[NO] Can Add to Free Membership Site
[NO] Can Be Given Away For Free

If you need further clarification of the above terms, or there's something you 
have a question about that isn't mentioned above, please feel free to contact 
me right away at either: admin@e-bookemporium.us or 
tyates0711@yahoo.com and I would be glad to help.

Thanks for your purchase and enjoy your new ebook template 'how to' guide!

Sincerely,

Tracy Yates
EZ Ebook Templates.com
E-Book Emporium.us Membership Site
Hot Product Notify.info
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Legal Disclaimer
All contents copyright © 2009 by Tracy Yates/EZ Ebook Templates.com. All 
rights reserved. No part of this document or accompanying files may be 
reproduced or transmitted in any form, electronic or otherwise, by any means 
without the prior written permission of the publisher. 

This ebook is presented to you for informational purposes only and is not a 
substitution for any professional advice. The contents herein are based on 
the views and opinions of the author and all associated contributors. 

While every effort has been made by the author and all associated 
contributors to present accurate and up to date information within this 
document, it is apparent technologies rapidly change. Therefore, the author 
and all associated contributors reserve the right to update the contents and 
information provided herein as these changes progress. The author and/or all 
associated contributors take no responsibility for any errors or omissions if 
such discrepancies exist within this document.

The author and all other contributors accept no responsibility for any 
consequential actions taken, whether monetary, legal, or otherwise, by any 
and all readers of the materials provided. It is the readers sole responsibility 
to seek professional advice before taking any action on their part.

Readers results will vary based on their skill level and individual perception of 
the contents herein, and thusly no guarantees, monetarily or otherwise, can 
be made accurately. Therefore, no guarantees are made.
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How To Open An EZ Ebook Template
This is going to be the easiest and shortest chapter for you to read. 

If you have never used an EZ Ebook Template before, then it is 
imperative that you read all the instructions below.

The first step is, if you don't already have a copy of OpenOffice Writer 
installed on your computer, then you will need to do that before 
attempting to open any EZ Ebook Template.

So, go to http://www.openoffice.org and download the OpenOffice 
Suite of tools as shown below:

All you need to do is to left click on the same image shown above and 
a new image will appear that looks like the one below:

Once you see the 'Download now!' area simply left click it if you are 
running a Windows Operating System and your download will begin.

If you are running something other than Windows on your computer 
system, or have a different language set up, then you will need to click 
the 'more platforms and languages' link as shown above.

At the time of this writing, the newest available version of OpenOffice 
Suite is 3.0.1. Which of course the Writer program is included.
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Once you have the OpenOffice Suite completely downloaded, you will 
need to install it.

To do that, simply double left click on the finished .exe file that should 
be named: Ooo_3.0.1_Win32Intel_install_wJRE_en-US.exe. Or 
something similar.

Then follow the on screen instructions that will take you through the 
process of installing.

After you have the program fully installed, then you should be able to 
navigate to the OpenOffice Writer program either through your Start 
Menu or by left clicking on the new program icon on your desk top (if 
you selected adding one during installation) that looks similar to this:

You will discover that once you start up the Writer program for the first 
time that afterwards you will be able to double click on any of the EZ 
Ebook Template .ODT files and it will directly open up with the Writer 
program.

If that doesn't happen, then you can always 'right click' on any of the 
EZ Ebook Template files and select the 'Open With..' option from the 
pop up menu and then browse to the program inside your Programs 
folder which should be located here: C:\Programs(or   Program   
Files)\OpenOffice.org 3\swriter.exe

And that's all there is to opening up any EZ Ebook Template!
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How To Edit Headers & Footers
You would think that making changes to the header and footer of an 
EZ Ebook Template would be difficult. But it isn't. It's actually very 
easy.

Don't misunderstand. It can get a bit complicated if you opt to make 
drastic changes, but nothing one cannot get a full grasp of with 
practice ☺

For now, we'll just stick with the basics and not change any of the 
header or footer layouts. I'll show you how you can do that easily 
afterwards.

What & Where Are Headers & Footers?
The Headers and Footers of your document will be exactly where you 
think they might be...

Headers reside at the very top of every page of your ebook document. 
In this particular ebook guide, the Header is positioned at the top of 
each page and looks just like this:

 
And of course, the Footers are found at the very bottom of every page 
of your ebook document. In this guide, they are of course positioned 
at the bottom of every page and look like this:

You can add graphics backgrounds to your Headers and Footers, 
standard color schemes, borders in various styles, etc. Basically, you 
can style your Headers and Footers in any method you choose.

In our case, for the basics, we're going to stick with standard 
background colors and borders. We'll get into the tougher elements a 
bit later on in this section.

To begin with, when you open up a fresh new text document inside 
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OpenOffice Writer, there are no Headers and Footers in place. You 
have to add those in yourself. Even though this isn't the case with any 
of the EZ Ebook Template designs as those are already pre-done for 
you.

However, I am going to teach you how to put in your very own brand 
new Headers and Footers so that you will know exactly how to do this 
whenever you need to. Then afterwards, we'll discuss how to edit a 
basic Header and Footer inside of an EZ Ebook Template.
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How To Create New Headers & Footers Inside Your 
Text Documents
The first step in creating new Headers and Footers inside your new 
text document is to create a new text document.

To do this, you will need to open up the OpenOffice Writer program 
and once loaded, you will see a fresh new text document waiting to be 
filled with contents. Like this:

Notice that there is just a clean white surface to write on. Kind of like a 
sheet of blank paper.

The next part is to add in the default Header and Footer into your new 
text document. Because in order to create a certain style for our 
Header and Footer, we first need to add them into our existing 
document. And, here's how to do that....
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To add a default Header to your new text document, left click the 
'Insert' link found in your main upper tool bar, as pictured below:

You'll notice that when you click that link, a drop down menu expands 
giving you further options on what you wish to insert to choose from.

You want to find the 'Header' option listed. Roll your mouse over that 
option and another simple menu will display with the word 'Default' 
written in it. Left click on the word 'Default'.

Then you will notice a whole new section inside your plain text 
document appear like below:
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And you do the same thing for adding a new Footer to your text 
document, only difference this time around is you hover over the 
'Footer' option and left click 'Default'.

Then you should see another new section like below:
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Now we're going to get into the fun part...Editing our plain Header and 
Footer.

For this part, we're simply going to add a background color and some 
borders.

We will also add a sample ebook title and a page number count field.

First, let's begin with adding a background color to the Header. Then 
we'll do the same for our Footer. Let's begin.
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How To Add Elements To Your Header
To make adjustments to the Header, you'll need to left click once inside 
the Header section so that your cursor is blinking inside of it like 
pictured below:
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Obviously in my screen capture image, you won't be able to see the 
cursor line blinking, but you should be able to see that it is when 
following these steps.

The next thing we need to do is to right click inside the Header section 
and select the following from the pop up menu:  Paragraph..  by left 
clicking it once.
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A new window will appear that looks similar to this:

If the Background selection portion isn't already showing, you will 
want to left click on the 'Background' tab inside that window.

Once we are in the right section, it's time to pick out a color. 
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Be sure that you have the 'Color' option selected from the drop down 
menu as shown below:
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Then, from the color palette displayed, select any color you wish. 
When you pick a color, it will show up in the small preview window 
immediately to the right of the color selection section:
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I selected a rich purple color, you may have chosen something a little 
different for yours.

Next, we are going to set some borders up for our Header.

To do this, with the Paragraph.. window still open, we will left click 
on the 'Borders' tab. 
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Now you should see the following:

You will see several different options available to choose from. For 
now, we are going to add a top and bottom black thin line border to 
our Header only. We'll do something a little different for our Footer.

First thing we need to do is set the Line arrangement. We can either 
select the top + bottom border preset or we can left click inside the 
'User-defined' box to set them, one left click for the top and one left 
click for the bottom. 
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I have made a couple instruction images for you below so you know 
what I'm talking about detailing both methods for setting the Line 
arrangement:

One Click Top + Bottom Line Arrangement Setting Method
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TWO CLICK TOP + BOTTOM LINE ARRANGEMENT 
SETTING METHOD

The “two click” method really gives you more control when you only 
want to add one border in a particular area of your Header, even 
though you can use it as I have specified. 

That's why it's important for you to know how to do this as the 
'Default' settings only give you so many choices and sometimes you 
may want something that looks a little different than those.

Okay, moving forward...

When we set this parameter, we tell OpenOffice Writer where we want 
our borders to be within the Header, and these will be placed 
throughout every page in our entire text document. 
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Best part is, we only have to set this one time. And if we want to make 
any changes, it will also distribute those changes throughout our entire 
text document with just a few simple clicks. Don't you just love the 
'Paragraph..' window?!

The next couple things we must set is the size, or thickness of our 
border lines, and what color we want them to be. For our border, we're 
going to select the smallest, or thinnest, line size of 0.05 as you can 
see below:

As you can see, there are several border line options available to you, 
and you can choose any one of the settings listed in the 'Style' section. 

But for the purposes of this quick demonstration, I'm going to stick 
with the very first option. And that is the thinnest border line setting 
option available.
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After we have our border line size set, it's time to choose a color.

The image below displays where you select your border line color:

I'm sticking with Black for this example, but you can left click on the 
'down arrow' on the 'Color' setting to see more colors you can choose 
from.

Any color you select will set the color for all your borders.

Also, you could even add a shadow behind your border lines if you 
wanted to. You can do that by clicking any one of the 4 options within 
the 'Shadow style' area shown above.

Even though there are 5 options, the first one is a 'no shadow' setting, 
that's why I say you have 4 other options to choose from. Those 
additional 4 will place a shadow behind your border lines.
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Then you can set the color of your shadow as well from the 'Color' 
drop down menu also shown above. As well as the distance your 
shadow effect will be from your border lines. And that can be set 
inside the 'Distance' area.

Once you're all done with the settings, simply hit the 'OK' button. You 
will then see all the changes you've made appear inside your Header.

It's important to remember that to make any change stick, you'll need 
to hit the 'OK' button when finished.

And here is what I ended up with:
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Depending on the colors, the placement and number of border lines, 
and border line thickness you selected, yours may have turned out a 
bit differently.

Now you know how to set borders up inside a Header.

All we need now is a little bit of text inside our Header, so I am going 
to add some with the following settings: White color, Times New 
Roman Font, 12 pt size, with the words 'Your Ebook Title Goes 
Here'.
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First, you will want to type in your ebook title text, like pictured below:

I added in a couple extra spaces in front of my text by hitting the 
space bar twice.

As you can see, the default text color is black. But that's easily 
changed.

First highlight all the text you want to change the color for by holding 
down the left mouse button and dragging across the text, and once 
the text is highlighted, left clicking the following button and select a 
different color, in this case white, from the pop up text color menu:
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We simply left click on the color swatch we want, and then you will see 
your highlighted text will change to that color:

And what about adding a page number? How do we do that?

Well, I'm going to tell you right now.

In our example, we didn't use any type of table to separate our page 
number from our ebook title text, so instead, we're just going to add 
some space in between where our ebook title text sets and where we 
will place our page numbering system. We'll do that by simply hitting 
our space bar on the keyboard until we feel there's enough space in 
between our 2 Header elements.

Then, after we have ample space, it's time to slap in our page 
numbering system. To do this, you will need to select: 'Insert' from the 
main tool bar menu by left clicking it once.

When the next menu appears, select 'Fields'.

Then you will see yet another menu off to the right hand side. From 
that menu, select: 'Page Number'.

Then you should see the following new element inside your Header:

That is your page number field. And it will number every single page 
automatically inside your text document, or ebook, or special report, or 
whatever you're creating ;-).
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I like to add the word 'Page' in front of my page numbers, but you 
might not. You can add anything you want to before, or after your 
page number field. All you have to do is left click right in front of, or 
behind the page number field and add what you want.

You can even add more spaces in between your ebook title text and 
your page number field if you like.

There is one other element you can add that you may have seen inside 
other ebooks before. Something that looks sort of like this: Page 1 of 
35

Or something similar.

You can do the same thing with OpenOffice Writer too!

And I'm going to tell you how to do it.

The first thing you will want to add is the word 'Page' right in front of 
your page number field element.

Then, you will want to left click directly behind your page number field 
element and add an extra space. Type the word 'of' there, add another 
space and go back up to your main tool bar and select: 'Insert' > 
'Fields' > 'Page Count'.

You should then see something similar to the image below:

Now, because you added those extra elements inside your Header, 
those will span across every new page you create. Just like everything 
else within your Header.

Remember, you can change anything you like inside your Header. Plus, 
it's pretty easy once you know how :-).

It's the same process if you wanted to add these types of settings 
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within your Footer. But, as I said earlier, I want to teach you something 
a little different, so we'll be setting our Footer with other parameters.

Let's do that now...
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How To Add Elements To Your Footer
Adding things to your Footer is practically the same process as what 
you did previously with your Header.

Except with our example Footer, we'll be keeping it super simple.

For our Footer, we'll be adding a background color, some text, and a 
hyperlink.

The first step is to left click once inside of our Footer.

Then to open up the same 'Paragraph..' window to adjust our Footer 
settings, all we need to do is right click inside the Footer section.

From the 'Paragraph..' window, we'll select a background color, just as 
we did earlier with our Header:
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This time, I decided to go with a yellow background color, just so you 
could see the difference.

That's the only thing we need to set for the Footer using the 
'Paragraph..' window. So you can simply hit 'OK'.

Now your Footer should look something like this:

Nothing fancy, just a plain old yellow Footer...for now.

Let's add some text.
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Most ebooks are going to have a copyright notice somewhere within 
them. A lot will have this posted inside the Footer area. In regular old 
HTML, you would need to hand code the phrase: &copy; to create a 
copyright symbol. 

Not so inside OpenOffice Writer. 

We can plop one of those anywhere we want, and with just a couple of 
clicks too.

Here's how to put the copyright symbol inside your Footer. 

Select: 'Insert' > 'Special Character...' 
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You should see a new window open up that looks similar to this:

Did you spot the copyright symbol in the image above yet? No? Well, 
let me point it out for you:

Ah ha! There it is :-).

To add that symbol to your Footer, or anywhere else in your document, 
all you need to do is left click it once, and then hit 'OK'. Magically, it 
will appear inside your text document wherever your cursor is placed.

For us, it's going to show up right inside our plain old yellow Footer. 
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And it's going to look something like this:

Now, I'm going to adjust the font to something different than Times 
New Roman. I think I'll use Tahoma instead. 

So, to change the font style of not only the text I'm about to add, but 
also the style of the copyright symbol, I first need to highlight the 
symbol by holding down the left mouse button and dragging across it.

Once it's highlighted, I'll need to select the new font style from the 
drop down font menu:

Now here's what I ended up with after changing the font style and 
adding a bit more text to my Footer:
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That's a little better. But I want my text in the center of the footer 
instead of aligned on the left hand side as it is now. 

So I'm going to set that by clicking on the 'Center' button:

And here's what happened:

While you might not be able to see it that great from the above image, 
everything is now center aligned inside the Footer.

The next thing I want to do is create a hyperlink on the words: EZ 
Ebook Templates.com that points to my web site and that all my ebook 
readers can click on.

To do that, I will need to highlight the text I want to create a hyperlink 
from first.

Once that is done, all I will need to do is left click the hyperlink button 
and enter my link settings:

You'll notice that when you click the hyperlink button, a new window 
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will appear that looks similar to this one shown below:
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I need to make sure that on the left hand side of the window, I select 
the 'Internet' option:

By default, the type of hyperlink will be set as 'Web' just like shown 
above. And that's what we want.
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Now all I need to do is enter the web site link I want:

I will type that inside the 'Target' area by left clicking once to be sure 
I'm inside the right area, and then typing out my web site address. Or 
'url'.

Then, after I'm done with that, I'll set the 'Frame' as '_blank':
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And finally, I will hit the 'Apply' button. Then the 'Close' button.

©copyright 2009 Tracy Yates/ EZ Ebook Templates.com

http://www.ezebooktemplates.com/


  EZ Ebook Template Instruction Manual                                                                                                        Page 49

Here's the result:

Now when I create a PDF, which I will show you how to do in a later 
chapter, my link will be fully 'clickable' by anyone who reads my ebook.

You can put hyperlinks like this anywhere inside your text document, 
and not just inside the Footer section.

Now that you know the basics of adding and editing a Header and 
Footer, it's time to move forward and learn how to add and edit 
background graphics inside them. 

How To Add Background Graphics To Headers & 
Footers
You might think this process is hard, but it isn't. Adding graphical style 
backgrounds to portions of EZ Ebook Templates is pretty much the 
same process.

So you will find that process repeated throughout this guide with a few 
slight differences.

We'll begin with adding a graphical background to a Header. To do this, 
simply right click anywhere inside your Header portion.

When the pop up menu appears, select 'Paragraph..' from the 
options listed.
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A new window will appear:

 
Be sure that you have the 'Background' tab selected. Then from the 
drop down menu pictured and circled above, select 'Graphic'.

Next, hit the 'Browse' button and find the graphic image you'd like to 
use for your Header background on your hard drive.

Then hit the 'Open' button.
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You should see your image appear inside the 'Preview' window:

I'm using the header image graphic from EZ Ebook Template #6 in EZ 
Ebook Template Package #1.

This time, instead of using the 'Tile' option inside the 'Type' area, 
we're going to use the 'Area' option. That way the image will only fill 
up the used portion area of our Header. It makes it look much cleaner.

Then hit the 'OK' button.
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And here's how my Header turned out:

Not too bad.

If you want to do this for your Footer, the process is exactly the 
same. The only difference is you right click inside the Footer area of 
your EZ Ebook Template.

And that's why I'm not including a separate instructional 'how to' on 
doing that.
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How To Add & Edit Background Graphics
This chapter is going to cover adding and editing background graphics. 
These techniques can be applied to graphics that accompany any EZ 
Ebook Template package, or that you have collected from another 
outside source.

The most important tool you will need on hand to follow along and 
perform these tutorials yourself is an image editing program.

It can be Photoshop®, GIMP, Paint Shop Pro, or anything else you 
might have. However, it's important to note that the tutorials will show 
you how to edit background graphics using Photoshop, although if you 
know your image editing program inside and out, you should be able 
to adapt the following instructions easily enough.

Throughout this tutorial section, I will be using the graphics editing 
program that I have. And that is Adobe® Photoshop® 7. 

Now, if you do not have an image editing program, you can get any 
one of the following for free:

Adobe Photoshop CS4 Extended - 30 Day Trial ( click on the link next 
to the little 'PS' icon on the page )
GIMP – Totally 100% Free To Download and Use Forever
Paint Shop Pro Photo X2 – 30 Day Free Trial ( click on the 'Download 
Free Trial' button )
Paint.NET Free Image Editor – Totally 100% Free To Download and 
Use Forever
Photobie – Totally 100% Free To Download and Use Forever

Personally, I've never used any of the above programs, with the 
exception of Photoshop, so I don't know how they fair against it. I've 
heard that GIMP is the way to go if you can't afford to purchase 
Photoshop, or if your free trial has run out :-).

If you decide to use GIMP, I found a couple of web sites that offer free 
video tutorials here:

http://sixrevisions.com/graphics-design/gimp_video_tutorials/
http://gimp-tutorials.net/ 
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That should get you started in the right direction.

Again, I will be using what I have, Photoshop 7, to explain the editing 
processes outlined in the following chapter. In my opinion, if you don't 
already have Photoshop, or don't have the newest available edition, 
then you should really download the free 30 day trial. That will help 
you follow along easier.

With all of that out of the way, the first thing I'm going to teach you is 
how to add a background to a new text document. We'll just continue 
on using our previous example.

How To Add A Background To A New Text Document
With our newly created text document, we don't have any type of 
background. It's just a plain old white canvas. Let's add a splash of 
color to it by adding in a background image.

I'm going to use a pre-made background that comes with EZ Ebook 
Template Package #2, but you can do this with any extra background, 
or existing background graphic image that comes with any of the EZ 
Ebook Template packages.

And it looks something like this:
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To insert the background I've selected, we'll need to return to our new 
text document and right click anywhere inside the plain white, main 
portion of our document:

A pop up menu will appear.

From it, you will want to select: 'Page..'
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Then, a brand new window will appear that looks like this:

As you can see from the above image, the 'Background' tab is already 
selected. If it is not when you open the 'Page...' window/menu, then 
you must first select it by left clicking on the 'Background' tab.

Next, we are going to select our background image so we can add it to 
our new text document.
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To do this, we will need to select 'Graphic' From the 'As' drop down 
menu:

As you can see from the image above, when we select the 'Graphic' 
option, the entire menu of options changes.

Now, to input the background image, we will need to hit the 'Browse' 
button and locate the image file on our hard drive. 
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A new window will open up and look similar to this one:

Next, you'll need to navigate to the image file on your hard drive.

Once you find it, left click the file once and hit the 'Open' button.
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You will see a smaller version of the background image inside the 
preview section:

While you can't see it very clearly in the above image, the background 
preview is there. 

The only way that you would not see the preview of the image is if the 
'Preview' box was not already checked. If it's not, and you can't see 
your background image in the preview box, simply click the 'Preview' 
box and it will appear.

Next thing we need to do is to make sure that our selected 
background image will show up properly. For the background I 
selected, the image needs to tile across the entire background of the 
new text document.
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To do this, we will need to make sure that the following is selected 
inside the 'Type' section:

This will ensure that our background image will tile throughout our 
text document.

The other two settings are used for absolute positioning and adding a 
background image to a specific area such as a table, etc.

Once we have all our settings just as we want them, it's time to add 
the image to our text document as the background by hitting the 'OK' 
button shown above.
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Now you will see the background inside your text document tiling 
along the side:

Obviously, we won't want our text to overlap that side border, so we'll 
have to adjust the margins.

We can do that by opening up the 'Styles and Formatting' window 
by either hitting the F11 key on the keyboard or selecting: 'Format' > 
'Styles and Formatting'.
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Then, we need to make adjustments to the 'Default' section as shown 
below:

To make these adjustments, we need to open up the 'Default' settings 
menu. Do this by right clicking on the text 'Default' and selecting 
'Modify' from the 2 available options.
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A new window will appear:

We need to go to the 'Indents & Spacing' section, which in the 
preview image above, is already selected. If it isn't when you open up 
the 'Default' style settings window, then simply left click it from the 
tabbed menu seen above.

In the image above, you can see that there are several settings we can 
change. The only 2 we need to be concerned with is the 'Before text' 
and 'After text' options.

We will need to set those. You can do this by left clicking on the up or 
down arrows beside the 0.00” number(s). Or you can simply input the 
numbers directly inside the 0.00” boxed area.

For our text document, we need to set the 'Before text' to: 1.24” and 
the 'After text' can be left as it is, or it can be adjusted to leave a little 
extra white space at the end of our document contents.
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I set the 'After text' at: 0.12” for a nice clean look.

Here's the result:

Notice that not only did the text margins change within our document, 
but it also changed the margins within our header.

That's okay though because it looks better without the 2 colors 
overlapping each other.

The best thing to do for setting margins is to play around with all the 
'Paragraph styles' settings inside the 'Styles and Formatting' 
menu. 

And, if you don't want to change the way your Headers and Footers 
look as far as margins go, you can always set the 'Text Body' style 
instead and that will only add margins to your, well, text body of the 
document :-).
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How To Change A Background In Any EZ Ebook 
Template
Now we know how to add a brand new background image to our text 
document.

But what if we just want to change an existing background image to 
something different?

That's fairly simple once you know how to add a background image. 
Changing a background image is grounded on the same principles as 
adding a new background. Just a little different.

Here's what you need to do to change an existing background inside 
any EZ Ebook Template to something else.

First, you need to open up the EZ Ebook Template you want to work 
with:
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I opted to use Template #2 inside the EZ Ebook Template Package #1. 
You may decide to use a different one. This technique will work for any 
of the EZ Ebook Templates.

If you have OpenOffice Writer installed on your computer, which I 
hope you do by now, then all you will need to do is to double left click 
the .ODT file on your hard drive.

Once you've got the template opened up, you will want to right click 
anywhere inside the main portion of your document, or ebook 
template, which I showed you how to do in the earlier section of this 
chapter, and select 'Page...' from the pop up menu.

From there, we will change our current background image to 
something different by selecting the 'Background' tab, if it isn't already 
selected:
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Now we have to hit the 'Browse' button, navigate to our background 
image we want to add, highlight it by left clicking it, and then hit the 
'Open' button.

Check the preview window to be sure that you have the right 
background image selected and finish up with your 'Type' settings.

Again, I have left this set to 'Tile' so that the new background will 
cover the entire main portion of the EZ Ebook Template document 
area.

Then, simply hit the 'OK' button to submit your changes.

And here's what I changed the background to:
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A nice plain and simple notebook style background I had stashed away 
inside EZ Ebook Template Package #5. Nothing fancy, but it's a good 
example of how different a template can look just by switching out the 
background.

How To Edit An EZ Ebook Template Background
Many of the EZ Ebook Template packages come with editable 
Photoshop files, or .PSD files, so that you can change certain elements 
of the EZ Ebook Templates and create something new. Or something 
that better suites your taste :-).

And that is what this section will teach you....How to edit an EZ Ebook 
Template background.

You can edit a background whether it comes in the .PSD file type, or 
whether it's a plain old .JPG or .JPEG. Certainly, having the .PSD file 
will give you much more control on what you can change, but if you 
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simply want to change the colors on a .JPG or .JPEG background, you 
can do that too.

I'm about to show you how right now.

Let's begin with making changes to a .PSD file background. For this, 
you will need to have Photoshop 7 or higher installed on your 
computer. Or at least an image editing program that can open up 
these types of files. GIMP will also do fine.

I'm going to select this background for this part of the tutorial:

Look familiar?

It should. It's the exact background image I'm using for this particular 
ebook! Well, part of it anyway :-).

Kind of small though. There's a reason for that. The reason is that the 
image is set to seamlessly tile across any specified area. Just as you 
see it being displayed along the sides of this ebook.

In all actuality, it's really a separate layer put behind this solid, lighter 
portion of this particular background image I'm typing on. But, that's a 
little more complicated. So for now, we're simply going to change the 
color of the above tiny little square.
The first step is to open up the .PSD file inside an image editing 
program. I'm going to use Photoshop 7 since that's what I have.

To open it, and if you already have Photoshop installed, you can just 
double click on the file and Photoshop will pop open with your image 
inside, ready to edit.

If you're using something else such as GIMP, this process might be a 
little different. You may have to right click on the .PSD file and select 
'Open With...' then choose your image editing program from a list.

Either way, the image should now be open and ready to edit, like so:
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Depending on what version of Photoshop you're using, or if you're 
using an alternative image editing program, then you may see 
something a bit different from the above image.

Now, since we're only changing the color of the image overall, there's 
a really simple way to do this in Photoshop.

We are simply going to change the background color of our image 
through the layers menu:
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As you can see, there are two separate layers to our background 
image. The white striped layer and the background color layer. All we 
are going to adjust is the background layer.

If you cannot see the 'Layers' window inside Photoshop, you can turn 
it on by left clicking the 'Window' link on the main upper tool bar and 
selecting 'Layers'. Then it should pop open similar to what is shown 
above.
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To change the background color of our image, we'll need to left click 
on the background layer first as shown above, and select a new color 
from the foreground swatch by left clicking on it:

You should see the above pictured tool bar on the far left hand side of 
the Photoshop program already displayed.
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When you left click on the black, foreground color swatch, in your 
case, it will probably be white by default, a new window will appear 
allowing you to chose a new color that might look similar to this:

You can use the sliders to move up and down the color palette on the 
right hand side. It's the rectangle that looks like a rainbow.
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You will want to move the little circle in the upper left hand corner 
towards the right side of the 'Select foreground color' area like this:

When you're happy with the color, simply hit the 'OK' Button. Now 
your foreground, or top, color swatch should show the new color you 
have chosen:

Now we will need to grab the paint bucket tool. Be sure that you still 
have your 'Background' layer selected before we dump the new color 
in!
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Here's where the paint bucket tool is located on the left hand tool bar:

You select the paint bucket tool by left clicking on the paint can icon, 
and then inside your background image, you again left click. Your 
background image should change from this:

To this:

You can play around with all the colors you want until you get just the 
right background color.

All that's left to do is to save your new background image as a .JPG 
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or .JPEG file.

To do this, select 'File' > 'Save For Web..' on the main upper tool bar 
and a new window will appear similar to this one:

While the image above is too small to see all the details, you should 
know that on the far right hand side are all the image settings. We're 
going to use the following for our background image:
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With our newly created background image, we can now create a new 
background very similar to this one you see here in this ebook guide.

Here's how we do it:

Create a new document in Photoshop by clicking on the 'File' > 'New' 
options from the main upper tool bar:

A new window will open. In that window place the following 
parameters for your new image document:

The above are what I found to be the standard settings for creating an 
EZ Ebook Template background image with the default settings for 
OpenOffice Writer text documents.
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Once you've entered in the above image parameters, hit the 'OK' 
button. A new white image will then appear like so:

Next, we are going to take our previously created red background 
square and turn it into a pattern.

To do this, you will need to have your red background square opened 
inside your image editing software program. 
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Open, or re-open your background file by selecting: 'File' > 'Open..' 
from the main menu tool bar pictured below:

You will have to navigate to the place on your hard drive where your 
background is located in a new window, and then hit the 'Open' 
button.

Your background image should now show up inside your image editing 
program:
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The next step to converting our background into an actual pattern we 
can use is to use the 'Rectangle Marquee' tool. To use it, left click 
on the dashed square image shown below:
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Then, with the 'Rectangle Marquee' tool selected, we're going to 
hold down the left mouse button and drag across our entire 
background image.

Release the mouse button and you should see a flashing dashed 
background around the edges of your selected image:
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Obviously the above image doesn't show the line flashing, but it will 
show up like this in your image editing program.

Next, we need to select the following from the main tool bar: 'Edit' > 
'Define Pattern...'

A new window will appear and ask you to give your new pattern a 
name:

It may even automatically input a suggested name for you. Usually this 
is the name of the image file. Just like you see in the screen capture 
above.

You can choose to leave the suggested pattern name as it is, or give it 
a new one. That's up to you. After your new pattern has its name, all 
you need to do is click 'OK'.

The pop up window will close. To deselect the image, hit: 'Ctrl + D' 
on your keyboard. Alternatively, you can simply left click anywhere 
inside your background image as well.
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Now let's head back on over to our newly created plain white image:

We're going to add a new layer with our red background pattern 
flowing through it.

We do that by creating a new layer. To do this, you need to be certain 
your 'Layers' window is open. 
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If you don't already see it, and it should look similar to this:

Then you'll need to open it up by left clicking on 'Windows' > 'Layer' 
on the main horizontal tool bar menu found at the very top of the 
Photoshop program.

Moving on... 
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To create a new layer, you will want to left click the 'New layer' icon 
pictured below:

After you click it, you're new layer will appear similar to this:

That's where we'll be putting our seamless tiled red background.

To do that, we'll need to be sure that our new layer, 'Layer 1' is 
selected by left clicking on it inside the 'Layers' menu shown above. If 
it is already selected, it will be automatically highlighted.

Now, with 'Layer 1' selected, we're going to use our 'Rectangle 
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Marquee' tool again and while holding down the left mouse button, 
we're going to drag across our entire plain white canvas beginning 
from the top left corner and ending in the bottom right corner.

When you have that done, let go of the mouse button. 

You should see the flashing dashed line around the entire plain white 
image:

Next step is to add our pattern as a background to our selected layer.

We do that by first clicking on: 'Edit > Fill...' from the main upper 
menu.
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A new window will open that allows us to select what type of fill we'd 
like to add:

Inside the 'Contents' area, you want to be sure that by the word 
'Use:' you have 'Pattern' selected from the drop down menu, as 
shown above.

Next, we select our red background pattern from the 'Custom 
Pattern:' drop down box by clicking the down arrow.

A pattern selection box will appear. The red background pattern will be 
the last image in that box.

When you find the pattern swatch you want to use, left click the tiny 
thumbnail image of it, and then hit 'OK'.
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Now you should see the new red background pattern filled inside your 
new layer:

Hit 'Ctrl + D' on your keyboard to deselect the layer.

Now, create another new layer by clicking the 'New layer' icon again 
inside your 'Layers' menu, just as you did earlier.

You will see it sitting on top of your filled red background layer. 

That's exactly where we want it to be because we're going to make a 
plain white area so that we will have a nice clean area to place our 
ebook contents on.
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Again, be sure that your new layer, in this case 'Layer 2' is selected, 
and again, select the 'Rectangle Marquee' tool by left clicking it. 

Draw a rectangular shape situated in the middle of your pattern layer 
that extends from top to bottom. Like this:

Now, select the paint bucket tool by left clicking it. 
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The paint bucket tool can be found on the far left vertical tool 
bar/menu and looks like this:

We're going to fill our selected area with white. So in order to do that, 
hit the 'D' key on your keyboard, and then hit the 'X' key. 

You should now see a white swatch on top of a black swatch in the 
color area shown above ( the above image shows a black color swatch 
on a red color swatch ).

With the paint bucket tool selected, or depressed, left click inside the 
flashing dashed lines you just created.
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You should end up with something looking similar to this:

Now hit 'Ctrl + D' to deselect the white area.

Your new background is for the most part finished. You can feel free to 
add extra lines, drop shadows, etc. to your background before you 
save it. Which is the next step.

To save your new image as a background for your EZ Ebook Template, 
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select: 'File > Save For Web...' from the main horizontal menu.

A new window will appear with a preview of your image and a section 
for your images parameters. I usually save my backgrounds as .JPG 
or .JPEG files, but feel free to play around with those settings on the 
upper right side.

If you're happy with the way your background image looks, simply hit 
the 'Save' button.

Another new window will appear where you give your new background 
a name and place it on your hard drive. When you're done, just hit 
'Save' again.

To use your new background inside your EZ Ebook Template, follow 
the steps outlined in the previous section: 'How To Change A 
Background In Any EZ Ebook Template'.
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How To Add Your Ebook Content
When using an EZ Ebook Template, adding ebook content is mainly a 
matter of copying and pasting. Reason being is that a majority of 
ebook content is going to consist of plain text type content(s).

Although it can be a bit more complex if you're adding images 
throughout your new ebook. But I'll explain how to add that type of 
content later. 

First, we're going to get down to the copy & paste basics of adding 
your pre-written content.

Adding Plain Text Content To EZ Ebook Templates
The best kind of content to copy and paste would be in a plain text 
document format, or .txt type file, because it's easiest for OpenOffice 
Writer to auto-format.

Even though, you can copy and paste content from any type of 
resource, such as .doc files, .rtf files, or even .html files. With these 
types of files, you may have to do a bit more extensive formatting by 
applying a pre-made style inside an EZ Ebook Template to them 
manually.

If that's the case, then all you would need to do is highlight all the 
content you want to apply a pre-made style to, and select that style 
from the style drop down menu located next to the Font drop down 
menu.

For the purposes of this instructional tutorial section, I'm going to 
assume that you have a plain .txt file and go from there. Remember 
too that this process will be pretty much the same no matter what 
source file for your ebook content you are using is.

So, first step is to open up your chosen EZ Ebook Template.
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Go to the first chapter and highlight all the subsequent text under the 
Chapter Title Heading. Like this:

Do Not Do Anything Further To The Highlighted EZ Ebook 
Template Text Yet!

Simply leave it as it is and follow the next step.

Next thing you'll want to do is to open up your ebook content text file 
and select the entire first chapter, or the entire contents, whichever 
you wish to do, by holding down the left mouse button and dragging 
your mouse down across all the content.

Once it's selected, or highlighted, right click and select 'Copy' from the 
pop up menu.

Then go back to your EZ Ebook Template, right click anywhere inside 
the highlighted, or selected sample text, and choose 'Paste' from the 
pop up menu.

Now you should see your new content added.

And that's really all there is to it.

You can opt to copy and paste chapters, or the entire document all at 
once. The choice is yours. Understand that if you do decide to copy 
and paste your entire ebook content all at once, you may have to add 
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additional Chapter Titles, Sub Chapter Titles, or format those that are 
already included.

Other than that, it truly is this simple to add your ebook content to any 
EZ Ebook Template.

In the next section, I'll teach you how to add, and format images to 
your ebook content quickly.
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Adding Images To Your Content Inside EZ Ebook 
Templates
Adding images to your ebook template is a very simple process.

Here's how to do it...

To add an image to your ebook, left click in the area where you want 
the image to appear.

Then, left click: 'Insert > Picture > From File...'

A new window will open allowing you to browse to the image you want 
to add.

Locate the image on your hard drive. Select it by left clicking it once, 
and then hit 'Open'.

When your image first appears inside your ebook template document, 
you will notice that it is on a separate line all by itself. 

You can move your image by left clicking on the image, holding down 
the left mouse button, and then dragging your image around your 
ebook document page. 

But, what if you want your text to wrap around your image? 

You can change this by right clicking on the image and selecting: 
'Wrap' and further selecting 'Page Wrap' or 'Optimal Page Wrap'.

There are additional settings you can play around with to get a feel for 
what else you can do with your images as well. I recommend you take 
some time to do that. The best way to learn is to experiment with your 
OpenOffice Writer program!
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How To Edit & Add New Chapters
While you might think that editing or adding new chapters to your EZ 
Ebook Template is difficult, nothing could be further from the truth. It's 
actually a pretty simple concept.

Editing Existing Chapters and Sub Chapters
Editing an existing Chapter inside any EZ Ebook Template is a fairly 
simply process.

Unless you need to change the text style, all you need to do to make 
changes to any existing Chapter Title text is to highlight it by holding 
down the left mouse button and dragging across the example Chapter 
Title text, and then retyping your specific, or actual Chapter Title.

For instance, say I wanted to change: 'Chapter Title 1 Goes Here', the 
example text, to 'How To Water Your Garden', then I would simply 
highlight the example text and type in my actual Chapter Title name.

The same applies for Sub Chapter adjustments.

Once you have changed a Chapter Title or Sub Chapter Title, you will 
need to scroll back up to the Table of Contents and right click 
anywhere inside the gray shaded area and select from the pop up 
menu: 'Update Index/Table'.

Then you should see the changes within the Table of Contents, or 
TOC.

Very easy process.
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Adding New Chapters and Sub Chapters
There's a pretty simple way to add a new Chapter or Sub Chapter to 
your EZ Ebook Template.

And that is to copy and paste and existing Chapter page into a blank, 
or new page.

To do this, just highlight an entire example Chapter page by holding 
down the left mouse button and dragging across all the contents of 
the Chapter page.

Right click and select 'Copy'.

From the main horizontal menu, select: 'Insert > Manual Break'.

Then, if you need to make adjustments to the Chapter Title text, 
reread the previous section and it will tell you how.

And, if you need to make adjustments to the chapter content text, 
then simply reread the 'How To Add Ebook Content' chapter and it will 
tell you exactly how to do that.

Everything is very easy to adjust so long as you know the basics.
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How To Edit or Add Table of Contents
Back when I created the very first edition of EZ Ebook Template 
Package #1, I only knew of one way to add a linked Table of contents. 

And that was by adding in links manually using the 'Bookmark' setting, 
or tool if you will. This was very difficult for many of the EZ Ebook 
Template users to make adjustments, or edit, the pre-built, manual 
Table of Contents.

So, I wanted to find a better way. 

And I saw all these other ebooks that had a fully linked, pre-formatted 
Table of Contents section and wondered, “How the heck did they do 
that?!”. Looking at all those ebooks told me that there was still more 
for me to learn...and to teach about creating ebook templates. You can 
only be the best by learning all you can about something.

Which, after hours of searching, I did. Now, EZ Ebook Templates are 
better than ever! And I'm going to teach you everything I learned that 
day.

The process of editing an existing Table of Contents is fairly easy. 

But adding a new Table of Contents is a bit more complicated. 

Don't worry, I'll walk you through both processes in this chapter and 
you'll be adding and editing Table of Contents like second nature when 
you're through reading.

And, you won't have to go searching hours to figure it all out on your 
own. I did that already so I could pass all that new found knowledge 
on to you making editing EZ Ebook Templates that much “EZ-ier” for 
you☺.
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How To Edit An Existing Table of Contents
I figured we'd start with the easiest option....editing an existing Table 
of Contents.

When you open up a new EZ Ebook Template that has a pre-built 
Table of Contents added, you will notice that it looks a little different 
than what is seen inside a PDF ebook.

The Table of Contents is highlighted in a gray color and will most likely 
look similar to this:

If you click on the 'Preview' icon on the main tool bar:
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Your ebook template document will open up in a different window 
showing you an example of what your completed product might look 
like.

As you can see, if you look closely at the Table of Contents, the gray 
areas behind it are gone. So there's no need to worry about that being 
a problem within your finished ebook product.

With that bit out of the way, I'm about to show you how easy it is to 
update your existing Table of Contents with just one click.

Might be hard to believe, but you can update your Table of Contents 
with just one click, and here's how to do it:

Go to the page where your Table of Contents resides.

Right click anywhere inside the gray area of your Table of Contents 
and select: 'Update Index/Table' from the pop up menu.

The menu will disappear and you will see that your newly added 
Chapters, and Sub Chapters if you have any, are now there. Complete 
with updated page numbers and all.

**Important Note: Anytime you add a new chapter, be sure that you apply the 
'Heading 1' style for your Chapter Title text, and the 'Heading 2' or 'Heading 3' 
style for any additional Sub Chapter Title text you might add. If you fail to do this, 
then no new chapters will appear inside your Table of Contents!

This is how it is done. And you can do this as many times as you need 
whenever you change, add, or remove ebook content. It's always the 
same process. Plus it's the easiest thing ever!
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How To Create A Brand New Table of Contents
While this process is more complicated than simply editing an existing 
Table of Contents, there's a lot to be said for knowing how to add your 
own. And in this section, I'm going to take you step by step teaching 
you how to do just that.

What you're going to learn in this section will allow you to utilize the 
"Indexes and Tables" function, and at the same time, make a 
clickable Table of Contents that leads right to your ebook chapters. 
And also sub chapters.

First though, let me tell you why this solution might be the better one.

The reason why I believe this is the better solution is because you 
won't have to manually update your Table of Contents every time you 
decide to add new content or new chapters to your existing ebooks. 

Simply by clicking ONE button, you can have your TOC, or Table of 
Contents, update itself...Including adding in new chapter links!

Can't get any better than that. At least, I don't think so.

Once you get the hang of using the "Indexes and Tables" function, it 
will come like second nature to you. I promise. 

Okay, the first thing we're going to need to do before we can even get 
to the point where we add our Table of Contents to begin with is to 
make some style changes.

This may sound complicated, but believe me, once you do it a couple 
of times, it gets really easy.

So, the first thing we'll need to do, beyond having our ebook content 
added to our EZ Ebook Template of course, is to open up the "Styles 
and Formatting" menu.

Yes, we've opened and used this before in earlier chapters, but I'm 
going to repeat the process here again for those that might have 
skipped or skimmed over the previous chapters.
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To do that, look for this link in your main tool bar of OpenOffice Writer: 

Click the "Format" link in the tool bar.

A drop down menu will then appear.

From that menu, select 'Styles and Formatting' by left clicking it 
once. Or, you could simply click the F11 key on your keyboard to 
open up the 'Styles and Formatting' menu.
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The Styles and Formatting window should now be open and look like 
this:

The next thing we're going to do is make sure that our ebook Chapter 
titles show up inside our official Table of Contents menu within our 
ebook. The way we do that is to assign a specific style to our ebook 
Chapters.
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For our main ebook Chapter titles we're going to use the 'Heading 1' 
style. This style can be found inside the 'Paragraph' styles section 
within the 'Styles and Formatting' menu that should be open by 
default. You will know which one it is by looking at what image button 
is depressed, and that should look similar to this:

Above, you can see where the 'Heading 1' style is on the list.

What you will need to do is to left click and drag across your ebook 
Chapter text to highlight it. Like so: 

And, if you don't have any text for your Chapter Title yet, then you 
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need to add that in before moving forward with this tutorial.

Next, you will want to apply the 'Heading 1' style to your Chapter 
Title text by selecting it from the styles drop down menu shown below: 

**Tip: An alternative method to applying any styles to your text, or ebook content, 
is to have open the 'Styles and Formatting' menu and with the text you wish to apply 
a specific style to highlighted, double left click on the style that is to be applied.

In your case, the drop down styles menu will more than likely show 
the 'Default' style. So to change it to the 'Heading 1' style, simply 
click on the arrow down and then select 'Heading 1' by left clicking on 
it from the drop down menu. 

Once you have applied the 'Heading 1' style, you will see that your 
ebook Chapter text has now changed from the default format to the 
Heading 1 style format.

The next step is to do the above for every single ebook Chapter Title 
text inside your ebook.

You may not like the way the default settings for the 'Heading 1' style 
look and want to change those. I will show you how to make those 
changes a bit later on in this section. 

For now the important part is to get all your ebook Chapter Title text 
set with the 'Heading 1' style so that they will show up properly when 
we create our Table of Contents.

You can also insert "Sub Chapters" within your Table of Contents.

How?
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By highlighting your Sub Chapter text then applying the 'Heading 2' 
style from the styles/formatting drop down menu just as I showed you 
above with the 'Heading 1' style. 

You will notice that the 'Heading 2' style looks a bit different. And 
when we create our Table of Contents, you will further notice that it is 
placed differently from our main Chapters as well.

Once you have all your Heading styles in place, it's time to insert our 
new Table of Contents.

For this, you will need to create a new, blank page to place your Table 
of Contents inside of. Most ebook authors like to place this immediately 
following their main 'cover' page. Which is normally the first page.

As you can see in this particular ebook guide, the Table of Contents is 
located on the third page down from the main, or 'cover', page.

So, to create a new page in between your ebook content and your 
'cover' page, you will need to go to the end of your main, first, or 
'cover' page, left click at the very end of all that page's content and 
select the following from the upper horizontal tool bar: Insert > 
Manual Break...
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You will then see a new window appear that offers you a few options 
like so:

You want to select the 'Page break' button, leave the 'Style' setting as 
it is by default, and hit the 'OK' button.

And a new blank page should show up directly following your first, or 
main, page.

Now that we have a fresh, new blank page, it's time to insert our Table 
of Contents.

Be sure that your cursor is blinking somewhere within your newly 
created blank page by left clicking once inside the new page.
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Then from the main tool bar, select the following:
Insert > Indexes and Tables > Indexes and Tables

A new window should appear that will look similar to this:

Before we close the above window to check out our newly added Table 
of Contents, we will need to click on the 'Entries' tab to ensure that 
all our Chapter Title text and Sub Chapter text become hyperlinks and 
will be fully clickable when we create a PDF from our ebook. 

Which we'll do a little later on in this tutorial guide.

©copyright 2009 Tracy Yates/ EZ Ebook Templates.com

http://www.ezebooktemplates.com/


  EZ Ebook Template Instruction Manual                                                                                                        Page 122

If you're having trouble finding the 'Entries' tab, here's a screen 
capture image to help you:

Before we begin linking our main ebook Chapters, be sure that inside 
the 'Level' section pictured above, where you see all the vertical 
numbers, that the number 1 is selected. 

It should be by default, but make certain beforehand.
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To make your Chapters appear to your readers as 'linked' Chapters, 
you will need to left click once inside the little rectangular box directly 
behind the text: E#
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Then click the 'Hyperlink' button as shown here:

Keep the above window OPEN!!

There's one more thing we have to do before we finish our work.
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You will need to do the EXACT SAME THING outlined above for the 
# area shown below:

Remember, left click once inside the little text box behind the # 
symbol, then click the 'Hyperlink' button.

Now, with that all done, simply hit the 'OK' button.

You should now see a standard Table of Contents inside what was 
once an empty blank page.

Pretty cool, huh?

However, if you have set up Sub Chapters, you might notice that those 
appear, but are not linked as your main Chapters are.

You can fix that.

To link to your Sub Chapters, all you need to do is to first reopen the 
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'Indexes/Tables' menu by right clicking inside your newly created Table 
of Contents and selecting from the pop up menu: 'Edit Index/Table'.

Once the menu is opened, you will want to select the number 2 from 
the 'Levels' area.

Follow the outlined steps just as you did earlier for linking your main 
Chapter text and then hit the 'OK' button.

Now all your Sub Chapter titles should be linked as well.

The most important thing to remember is that you can have several 
different Chapter levels, and you will have to link up each one as 
shown above.

What that means is that if you are using, for example:

Heading 1 – Main Chapter Title Style
Heading 2 – First Sub Chapter Title Style
Heading 3 – Second Sub Chapter Title Style
Heading 4 – Third Sub Chapter Title Style
Heading 5 – Fourth Sub Chapter Title Style

Then for each of the 5 numbered Heading styles, you will have to go 
that many levels deep within the 'Edit Index/Table' menu to link 
each one.

In other words, for Heading 1, you will edit inside of Level 1. For 
Heading 2, you will edit inside of Level 2. For Heading 3, you will edit 
inside Level 3. And so on.

To edit inside different levels, you simply left click on the 
corresponding number for the specific Heading style number. Sounds 
difficult, but once you do this enough times, you'll become quite use to 
this process like second nature.

Next, we're going to get in to how you can make adjustments to the 
actual style of your Table of Contents.
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How To Change Table of Contents Text Style
You can make changes to the way your Table of Contents looks by way 
of the 'Styles and Formatting' menu. Remember, you can open this 
up by using the short cut key which is hitting F11 on your keyboard.

Before or after you open up the 'Styles and Formatting' menu, you will 
want to navigate back to the page that houses your Table of Contents.

To change your Table of Contents Heading, or where it says 'Table of 
Contents', simply left click inside that gray shaded area. 

When you do this, and if you have the 'Styles and Formatting' 
menu open, you will see that 'Contents Heading' style will become 
automatically highlighted like so:

Now, when that happens, to change the style of your 'Table of 
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Contents' Heading text, you will want to right click on the 'Contents 
Heading' link inside the 'Styles and Formatting' menu and then 
select: 'Modify..'.

A new window will open up that will look similar to this one:

Inside here, you can change the indents, or margins, before and after 
your Table of Contents Heading text, add line spacing above and below 
it, apply alignment attributes such as left, right, or center to your TOC 
Heading text, change the font, the font size, the font color, and even 
add a background color or image.

Click through all the tabs to see your options. The ones I have 
mentioned can be found inside these tabs:

Indents & Spacing – make changes to the margins and surrounding 
space

Alignment – adjust the alignment of your text by selecting left, right, 
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or center

Font – change the font style and size of your text

Font Effects – change the color of your text and add assorted effects 
such as shadows, outlining, underlining, etc.

Background – add color to the background of only the Table of 
Contents, or TOC Heading area, you can also choose to add a 
background image as well

Borders – add borders around your TOC Heading contents, and only 
to the Table of Contents Heading area

Once you have your TOC Heading looking the way you want, then you 
can move on and edit the rest of the Table of Contents styles.

If you use a 'Heading 1' style on your Chapter Title text within your 
ebook, then you will want to modify the following style inside the 
'Styles and Formatting' menu: 'Contents 1'

You do this in the same manner as you did for editing the Table of 
Contents Heading text.

So, you would left click inside the gray shaded area anywhere you see 
a 'Chapter 1 Title' text example in the Table of Contents. Then you 
will see the 'Contents 1' style inside the 'Styles and Formatting' 
menu auto highlighted. Just as before.

Now right click on the 'Contents 1' style and select: 'Modify' from the 
two available options.

You will see the same type of window open up again, and from there, 
you can make all adjustments as outlined earlier using the same 
process.

And, if you use any Heading styles for additional Sub Chapter 
Headings, such as 'Heading 2', 'Heading 3', 'Heading 4', etc., the styles 
you would change for those will correspond numerically. 
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For example:

Heading 2 – Edit Contents 2 in the 'Styles and Formatting' menu
Heading 3 – Edit Contents 3 in the 'Styles and Formatting' menu
Heading 4 – Edit Contents 4 in the 'Styles and Formatting' menu
Heading 5 – Edit Contents 5 in the 'Styles and Formatting' menu

And so forth.

Then, when you've finished making changes to all the styles within 
your Table of Contents, simply right click anywhere inside the gray 
area(s) and select: 'Update Index/Table' and you will see all the 
changes you've made. 

If they don't already auto update themselves once you make 
modifications to the styles.

Really that's all there is to editing your Table of Contents menu and 
changing the way it looks.
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How To Save Your Edited Ebook Template
This is 100% the easiest thing you will learn besides how to turn your 
ebook into a fully functioning PDF file. That chapter comes just a little 
bit later.

In order to save your ebook template once you've made adjustments 
and added content, which you'll want to get in the habit of doing 
often, all you need to do is to click the little floppy disk icon:

If, however, this is your first time editing, or you're creating a new 
ebook document, when you click on the above 'Save' icon, it will ask 
you to give your new document a name, and select a location on your 
hard drive to store it at.

Alternatively, if one clicking is too easy for you ;-), you can also save 
your ebook template by clicking: 'File > Save' or 'File > Save As..' 
from the main horizontal tool bar menu.

Remember, save your project often! Otherwise you could have a 
computer malfunction or other natural disaster and lose all your work.

And that's all there is to saving your ebook templates or documents 
once you've applied changes to them.

©copyright 2009 Tracy Yates/ EZ Ebook Templates.com

http://www.ezebooktemplates.com/


  EZ Ebook Template Instruction Manual                                                                                                        Page 132

How To Create A PDF From Your Ebook 
Template
This is by far the easiest thing you will learn. Besides what you were 
taught in the previous chapter.

It's a one click process with a few extra steps thrown in. But trust me, 
those little extra steps are a cake walk.

All right, to save your finished ebook project as a PDF file, you will 
need to do two things:

First, Left click on the PDF icon on the main horizontal tool bar:

Next, a new window will appear asking you to give your new PDF 
ebook document a name.

Name it anything you want.

Afterwards, hit the 'Save' button.

You can also browse to a different section within your hard drive if you 
want to place your PDF file inside another specific location or folder.

To look over your newly created PDF ebook, simply navigate to the 
place it is located on your hard drive and give it a good double left 
click (so long as you have Adobe Acrobat Reader installed on your hard 
drive beforehand).

If you need to make any further adjustments, reopen your original 
saved .ODT file, make the changes necessary, and then redo all the 
steps above to resave your document as a PDF file.

And that's all there is to that!
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Conclusion
You've made it to the end of the guide. Congratulations! Give yourself 
a great big old pat on the back for your accomplishment.

And remember, this guide is universal and will work for editing any 
existing or future ebook template in any package, so keep it handy in 
case you get a little rusty or forget a certain step. 

Plus, if you would like to print off this guide to keep it next to you, 
which can be very convenient, please use the printer friendly version 
that came with your download .zip file. It will save on printer ink, 
which can be very expensive ;-)

Now, if you missed any of the previous EZ Ebook Template packages, 
or currently don't own any, or maybe just one or two, I have listed all 
9 current available packages for you below on the next page to take a 
look at.

I wish you the very best on your next ebook or special report project 
and hope that my templates will aid you in creating a masterful work 
of art!

All The Best,

Tracy Yates
EZ Ebook Templates.com
E-Book Emporium.us Membership Site
Hot Product Notify.info
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Current EZ Ebook Template Packages Ready 
To Download Immediately

Package #1

6 Hot Ebook Template Designs For The 
Beginner In A Variety of Styles and Colors

Package #2

9 Exclusive Ebook Template Designs In An 
Exciting Variety of Styles and Colors

Package #3

Keep It Super Simple With One Style In 19 
Luscious Color Schemes All 'EZ' To Use!

Package #4

Pump It Up And Get 8 Different Styles & 
38 Yummy Color Schemed Templates 
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Package #5

One of the Biggest Ebook Template 
Collections To Date Packed With Extras

Package #6

38 Amazingly Stylish Ebook Template 
Designs With 5 Bonus 'Quick Start' Videos

Package #7

5 'White Paper' Type Ebook Template 
Designs For Use With Printable PDFs

Package #8

3 Cool Ebook Template Designs With All 
Tastes In Mind In Various Color Schemes

Package #9

4 New Professional Ebook Templates In A 
Fantastic Array of Color Combinations

Receive Updates On New 
Ebook Package Releases

Sign Up To Our Free Ezine Here & 
Also Receive A Free Gift On Us!

Sign up to the official EZ Ebook 
Template notification ezine list, 
[Ezdesign], and receive all the 
latest updates, new package creation 
notifications, special discounts, plus 
more all directly sent to your inbox!
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